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   ADOBE PREMIERE 
 

A project is a single Premiere file that describes a video program. It stores references to all the clips in that 

file and contains information about how you arranged the clips. It also includes details of any transitions or 

effects you applied. You can add and remove clips, organize clips into bins within the project. 

Selecting an initial workspace 
When you start Premiere for the first time (or when the Preferences file has been deleted), Premiere asks 

you to select an initial workspace. Based on your decision, Premiere optimizes the layout you will use to 

assemble and edit programs. Your choice of workspace depends on the kind of editing you will be doing.  

If you will primarily be dragging clips from the Project window to the Timeline, select the A/B Editing 

workspace. If you will be using more advanced editing techniques such as three- or four-point editing, select 

the Single-Track Editing workspace.  

Specifying project settings 

When you start a project, review the project settings, which are organized into five categories: 

General Settings 
Control the fundamental characteristics of the video program, including the method Premiere uses to 

process video.  

 

    Video Settings 
Control the frame size, picture quality, compression settings, and aspect ratios that Premiere uses when you 

play back video from the Timeline (the window where you edit your video program).  

Audio Settings 
Control the characteristics of audio you play back from the Timeline.  

Control frame-related characteristics when you build (render) and play back video previews from the 

Timeline. These options work in combination with the Video settings.  

Capture Settings 
Control how Premiere transfers video and audio directly from a deck or camera. (Other Project Settings 

panels do not affect capturing.)  

The appropriate settings for your project are usually determined by the current stage of your project. Many 

video capture cards provide their own presets or recommend project settings for optimal results. For 

information on comparing and changing settings, Keep the following guidelines in mind as you progress 

through your project: 
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 When setting up or editing a project, specify settings that will provide the quality you want when 

you play back the Timeline. For example, specify project settings that match the requirements of 

the final program or that temporarily lower the frame rate so that your computer can process 

edits faster.  

 If you are about to use a videotape deck to record directly from the Timeline, specify project 

settings that represent the final picture quality you want.  

Video settings 
 

Choose Project > Project Settings > Video, to specify the following options: 

Compressor 
Specifies the codec (compressor/decompressor) for Premiere to apply when building a preview of the 

Timeline. The codecs available depend on the Editing Mode specified by your preset or selected in the 

General Settings panel. Click Configure (if available) to set options specific to the selected codec. If you 

chose an editing mode provided by a manufacturer of a video-capture card or other hardware, see the 

documentation for the hardware, as it may recommend a particular codec for editing with that hardware. 

Otherwise, consider choosing a fast codec so that edits are processed quickly. If you want to play video back 

through your capture card to an NTSC or PAL monitor, choose the codec specific to your capture card. 

Depth 
Indicates the color bit depth, or number of colors to include in video played back from the Timeline. This 

button may not be available if the selected compressor provides only one option for bit depth. You can also 

specify an 8-bit (256-color) palette when preparing a video program for 8-bit color playback, such as for the 

Web or for some presentation software. The Palette button may be available when 256 Colors is chosen, if 

the selected Editing Mode and Compressor support creating custom palettes. When the button is available, 

click it and then either select Make Palette from Movie (to derive a color palette from the frames used in the 

video program) or Load Palette Now (to import a color palette you prepared and saved previously).  

Frame Size 
Specifies the dimensions, in pixels, for frames when you play back video from the Timeline. Ideally, you 

want the frame size for your project to match the frame size of your video clips. A large frame size shows 

more detail but requires more processing. If preview playback is slow, you can reduce the frame size to a 

smaller dimension, as long as your capture card supports it. When changing the frame size, keep the 

dimensions proportional to the original video clip. 

4:3 Aspects 

If you're using analog captured video, select 4:3 Aspect to constrain the frame size to the 4:3 aspect ratio 

used by conventional television. If you are using a D1/DV NTSC pixel aspect ratio, do not select this 

option. 
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Frame Rate 
Indicates the number of frames per second to play back video from the Timeline. In general, type a value 

that matches the frame rate of the final video, or type a lower value to process previews faster.  

Pixel Aspect Ratio 

Sets the aspect ratio for individual pixels. Choose Square Pixels for analog video, scanned images, and 

computer-generated graphics, or choose the format used by your video.  

Quality 
Affects the picture quality and disk space used when you play back video from the Timeline. Low quality 

usually plays faster and uses less disk space, and may be preferable for editing. High quality provides the 

best-looking image the selected compressor can provide, but requires more disk space. You can change the 

quality setting while working on a project without causing distortions or affecting the final output.  

Audio Setting 
 

Choose Project > Project Settings > Audio, to specify the following options: 

Rate 
In general, higher rates provide better audio quality when you play audio back from the Timeline, but they 

require more disk space and processing. Resampling, or setting a different rate from the original audio, also 

requires additional processing time and affects the quality; try to capture audio at the final rate. Note that 

with DV audio, you can capture only at the rate that was originally used to record the audio. In this case, it's 

best to match the predominant rate of the clips in your project. If you want to use a different rate in your 

final output, you can export at a different rate to resample, or you can change the rate in the project preset 

when you are done editing. 

Format 

Higher bit depths and stereo provide better quality but require more disk space and processing. 

Compressor 
Specifies the codec for Premiere to apply when playing audio back from the Timeline. The codecs available 

depend on the Editing Mode you specified in the General panel in the Project Settings dialog box. Click 

Advanced Settings (if available) to set options specific to the selected codec. Generally, you don't want to 

compress audio for playback from the Timeline; instead, compress audio when exporting. 

Saving and loading project settings 
 

Use the Save and Load buttons in the Project Settings dialog box to save all project settings into a file 

and later load them into a new project. Premiere comes equipped with settings files preset for typical 

programs, which you can adapt and save for your own projects. Most certified video-capture cards 

include preset settings files for Premiere. Adobe strongly recommends that if your capture card provides 

a preset file, you use it and do not manually change the settings. 
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Comparing settings using the Settings Viewer 
 

Premiere stores settings for projects and clips, as well as settings used when you export or capture files. 

To make it easier to see and compare settings, Premiere displays all settings together in the Settings 

Viewer window. Settings that do not match display in red. Avoid potential conflicts by matching 

settings for each of the four categories wherever possible. You can change Capture, Project, and Export 

settings by clicking the associated setting heading in the Settings Viewer window. 

Saving and auto saving a project 
 

Saving a project saves your editing decisions, references to source files, and the most recent 

arrangement of the program's windows. Protect your work by saving often. If you prefer, Premiere can 

save your project automatically at a specified interval. Premiere can either save the project to the same 

file each time or to a new file. For example, you can set Premiere to save a new archive of your project 

every 15 minutes, producing a series of files that represent the state of your project at each interval. In 

this way, automatic archiving can serve as an alternate form of the Undo command, depending on how 

much the project changed between each save. Because project files are quite small compared to source 

video files, archiving many iterations of a project consumes relatively little disk space. Adobe 

recommends saving project files to the same drive as your application.  

Opening a project 
 

You can open only one project at a time. Premiere recognizes Premiere project files created using 

versions 4.2 or later on Windows  

To open an existing Premiere project: 
Choose File > Open. Locate and select the file, and then click Open. 

Premiere doesn't copy the original source file into the project--it stores only a reference to the source file 

based on its filename and location at the time you imported it. If you move, rename, or delete a source 

file after you import it, Premiere will be unable to find it the next time you open the project. In this case, 

Premiere displays the Locate File dialog box, listing the missing file. You can resolve this situation 

using the options explained below. 

OK (Windows) or Open (Mac OS) 

Replaces the missing file if you first use this dialog box to locate and select the original file or its 

replacement, and then click this button. 

Offline  

Replaces the missing file with an offline file, a blank placeholder that preserves all references to the 

missing file throughout the project until you replace the offline file with the original file. 

All Offline 

Replaces all missing files with offline files, without asking you for confirmation. 

Skip 

Removes all references to the missing file throughout the project. All instances of the clip will disappear 

from the Project and Timeline windows.  

Skip All 

Removes all references to all missing files throughout the project, without asking you for confirmation. 

See Skip.  
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Important: Select Skip or Skip All only when you are certain that you want to rework all the instances 

where the file is used in the project. If you want to keep the file in the project but can't locate it at the 

moment, use Offline instead.  

Skip Preview Files 

Skips preview files if they cannot be found by their original path and file name. Preview files that can be 

found by their original path and file name are loaded automatically.  

Using the Monitor window 
 

The Monitor window displays individual frames of clips and the video program. Controllers at the bottom of 

the Monitor window are like the edit controller in an edit bay. You can edit clips in either the Monitor 

window or the Timeline window.  

In Dual View, the source and program are displayed side by side. You can also choose other views for the 

Monitor window. If you want to see only the program view, you can select Single View. For precise control 

over trimming, you can switch the Monitor window to Trim mode. 

Using Monitor window controllers 
 

The Monitor window contains similar controllers for the Source and Program views, which you use to view 

and find frames in a clip or video program. Many of the controllers work like the tape transport controls on 

a video deck.  

They serve the following purposes: 

- Use the Source controller (under the Source view) to play or view the frames of a source clip and to 

specify the clip's source In and Out points, which define the portion of the clip that will be added to the 

program. (The first frame that will be added is the source In point, and the last frame that will be added is 

the source Out point.)  

- Use the Program controller (under the Program view) to play or view the video     program in the Timeline 

and to specify a clip's program In and Out points, which define where the clip's In and Out points are on the 

Timeline. 

Viewing safe zones 

 

Television sets enlarge a video image and allow some portion of its outer edges to be cut off by the 

edge of the screen. This is known as over scan. The amount of over scan is not consistent across 

television sets, so you should keep important parts of a video image, such as action or titles, within 

margins known as safe zones. 
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Using Monitor window controllers 
 

The Monitor window contains similar controllers for the Source and Program views, which you use to 

view and find frames in a clip or video program. Many of the controllers work like the tape transport 

controls on a video deck. They serve the following purposes: 

Selecting an editing workspace 
 

The style of editing you use when working in Premiere depends on the task at hand, such as assembling 

a rough cut of a project or doing more precise editing. Premiere provides predefined editing workspaces 

that you can quickly and easily set up for the style of editing you want to use. Four editing workspaces 

are available: A/B Editing, Single-Track Editing, Effects, and Audio. 

A/B Editing mode is intended primarily for editors who wish to work by dragging clips from the Project 

window to the Timeline window. This mode resembles a conventional editing method called A/B roll 

editing, which uses two video tapes or rolls (A and B) and an effects switcher to provide transitions. 

Selecting A/B Editing sets up the following conditions: 

Using the Timeline window 
 

The Timeline is a time-based view of your program where you can select, arrange, and modify the 

instances of the source clips you've used in the video program. The Timeline graphically shows the 

placement of each clip in time, its duration, and its relationship to the other clips in the program. 

Customizing track views 
 

Depending upon the Workspace, the Video 1 track will display one of two ways. In A/B Editing mode, 

it displays as three subtracks: Video 1A, 1B, and the transition track. In Single-Track Editing mode, the 

three subtracks are combined. In this mode, the Video 1 track can display as either collapsed or 

uncollapsed. When it is collapsed, all clips and transitions are combined on one track. When it is 

uncollapsed, the view resembles that of the A/B Editing mode, except you cannot overlap the clips, and 

the separate tracks still behave as one track. You get only a visual representation of the overlap. The 

uncollapsed view is useful for obtaining a more accurate view of the transition overlaps. Choose 

between the collapsed and uncollapsed views by clicking the Track Mode button. 

Hiding and excluding tracks 
 

You can mark any track as shy, which means it can be hidden in the Timeline. Marking a track as shy 

does not immediately conceal it in the Timeline, because you must choose the Hide Shy Tracks 

command to conceal or reveal all shy tracks simultaneously. Shy and hidden tracks are included in the 

previews and exported program even when they are not visible in the Timeline. You can also exclude a 

track from a program. An excluded track still appears in the Timeline but is not included either in 

exported video or when previewing or scrubbing the Timeline. 
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Moving around in the Timeline 
 

The time ruler at the top of the Timeline displays the current time position of the edit line and any 

markers that have been set in the Timeline . From the time ruler, you can view the location of the In and 

Out points of a clip and the duration of the entire video program. When you do anything that repositions 

the edit line, such as clicking the Frame Forward button, you change the current frame in the Monitor 

Program view. 

Adding, naming, and deleting tracks 
 

The Timeline can contain up to 99 video and 99 audio tracks. You can add or remove tracks at any time, 

except for the Video 1, Video 2, Transition, Audio 1, Audio 2, and Audio 3 tracks, which cannot be 

deleted. New video tracks appear on top of existing video tracks, and new audio tracks appear below 

existing audio tracks. Deleting a track removes all clip instances on the track but does not affect source 

clips that you stored in the Project window. You can also change the name of any video or audio track. 

You cannot delete or rename the Transition track. 

To add one track: 

In the Timeline window menu, choose Add Video Track or Add Audio Track. 

Specifying source and target tracks 
 

When you add clips to the Timeline by dragging, the clip is added to the track and time position where 

you drop it. However, when you add clips to the Timeline using Monitor window controls or the 

keyboard, Premiere cannot know exactly how and where you want a clip to be added. In such a case, 

you must specify in advance the way a source clip's video and audio are added to the Timeline. By 

default, both source audio and video are added; in the Timeline, the Video 1A and Audio 1 Timeline 

tracks are the default target (destination) video and audio tracks. In the Timeline, the names of the target 

video and audio tracks are highlighted. 

You can control how source video and audio are added to the Timeline using the Take icons and Target 

menus. 

Locking and unlocking tracks 
Locking an entire track is useful for preventing changes to any clips on that track while you work on 

other parts of the program. A locked track is included when you preview or export the program. If you 

lock the target track, it is no longer the target, so source clips cannot be added to it until you unlock it 

and then target it. A locked track is marked by a lock icon next to the track name. If you position the 

pointer or a tool over a locked track, the pointer appears with a lock icon ( ) to remind you that the 

track is locked. Locked tracks are dimmed in the Target menus below the Program view. If you want to 

lock both a video track and a track with corresponding audio, lock each track separately. 

Editing In and Out points 
 

Most clips are captured with extra footage at the beginning and end to allow for more precise editing 

later. It's common to fine-tune the beginning and end of a clip just before moving a clip into the 
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program. Define the beginning of the clip by marking an In point (the first frame that will appear in the 

video program), and define the ending by marking an Out point (the last frame that will appear in the 

video program). 

Marking and finding In and Out points 
 

For numerical precision, set In and Out points using the Monitor Source or Program view. For visual 

precision, or if you prefer to use the mouse, edit directly in the Timeline using the edge trim tool. This 

interactive tool is useful for a rough cut, but it can also be as precise as specifying In and Out points 

numerically if you set the Timeline to display individual frames in the Time . The pointer automatically 

changes to the edge trim tool when you move the selection tool near the edge of a clip in the Timeline. 

For linked clips, the video and audio portions can have their own set of In and Out points, called split 

points. Split points are used to create split edits, such as an L-cut, in which the audio extends into the 

next clip. You can mark split points only when the Source view contains a linked clip. If you bring a 

linked clip into the Source view from the Timeline, be sure that Sync mode is selected first. 

Customizing the Timeline window 
 

You can customize the Timeline display, including how it represents clips when you view or edit them 

in the Timeline. For information on customizing the Timeline's tracks. 

To customize the Timeline window: 

1. In the Timeline window menu, choose Timeline Window Options.  

2. In the Icon Size section, select the size of the preview icon you want      in the Timeline. If you 

expect to use many tracks or work on a small monitor, choosing a small icon size will make it possible 

to display more tracks.  

3. In the Track Format section, select an option: 

The first option displays sample frames along the duration of a clip. This option makes it easier to 

find a frame, but slows display and does not include the filename. 

The second option displays the clip's poster and ending frames as well as the filename. 

The third option displays the poster frame and the filename.   

 The fourth option displays the filename only. This option displays the fastest. 

4. In the Audio section, choose an option from the drop-down menu. This option indicates the time 

zoom level at which an audio waveform will be visible in the Timeline.  

5. In the Options section, specify the following options as necessary, and then click OK: 

 

From the Count menu, select the unit of time displayed in the Timeline. 

Creating color bars and a 1-kHz tone 
Editors place color bars at the beginning of their programs to help a viewer calibrate the video monitor that 

will show the program. A 1-kHz tone is usually recorded underneath the color bars and is used to help 

calibrate the audio. You can create a single clip containing both color bars and a 1-kHz tone; this clip is 10 

seconds long. 
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To create color bars and a 1-kHz tone: 

Click the Create Item button at the bottom of the Project Window and choose Bars and Tone from the 

Create Type menu. 

Creating a counting leader 
A counting leader helps a projectionist verify that audio and video are working properly and are 

synchronized. You can create and customize a universal counting leader to add to the beginning of a 

project. The leader is 11 seconds long, so you may want to account for that duration as you plan to add it 

to the Timeline.  

Creating black video 
You can create a clip of black video to insert in any section of your program. The black video clip is 

a 640 x 480 still image with a duration of four seconds. Adjust the duration by dragging either edge 

of the clip. To insert a clip of a different color, use a color matte. 

Importing clips 
You can import clips into Premiere as a single clip, multiple clips, or an entire folder of clips directly 

into the Project window. If you want to examine a clip before importing it into the project, open the clip 

in a Clip window and then move the clip to the Project or Timeline window.  

By default, Premiere alters the size and aspect ratio of a video clip or still image to match that of the 

video frame you specified for your project. Premiere displays images with the correct frame aspect ratio 

in the Monitor and Trim windows.  

 

Premiere can import a number of video and audio formats.  

Video formats: 
Type 2 AVI, MOV 

Note: Type 1 AVI clips must be rendered before they can be previewed from your DV device. To render 

a Type 1 AVI clip, add it to the Timeline in a DV project, and build a preview file of that section of the 

Timeline. 

Audio formats: 
AVI, MOV, AIFF, WAV (Windows only  

Still-image and sequence formats: 
AI and AI sequence, PSD and PSD sequence, GIF and animated GIF, Filmstrip, JPEG, PICT and PICT 

sequence, TGA and TGA sequence, TIFF and TIFF sequence, BMP and BMP sequence (Windows only) 

Using markers 
Markers indicate important points in time and help you position and arrange clips. The Timeline and 

each clip can individually contain its own set of up to ten markers numbered from 0 to 9. In addition, the 

Timeline and each clip can individually contain up to 999 unnumbered markers. Working with markers 

is much the same as working with In and Out points; markers are only for reference and do not alter the 

video program (except for markers set up as Web links). In general, add a marker to a clip for important 

points within an individual clip, and add a marker to the Timeline for significant time points that affect 

multiple clips 

When you add a marker to a clip in Source view or the Clip window, it and any existing markers in the 

master clip are included with the clip when you add it to the Timeline or create a duplicate clip. 

However, if you open a clip from the Project window and add a marker to it, the marker won't be added 

to any duplicate clips or clip instances already in the Timeline.  
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When you add a marker to the Timeline or the Program view, it appears in both the Timeline and in the 

Program view, but is not added to any master clips. A marker you add to a clip in the Timeline appears 

with the clip, and a marker you add to the Timeline itself appears on the time ruler.  

Using Timeline markers for comments 
 

You can add comments to a Timeline marker, and if you are in QuickTime Editing mode, the comments 

are displayed in the Monitor window as ghosted text. The default duration for marker comments is one 

frame (the frame where the marker appears on the Timeline), and the comment displays when that frame 

displays. To display the comment for longer than one frame, increase the comment duration.  

To create a marker comment: 
 

1. Activate the Program view or the Timeline.  

2. Go to the time location where you want to add the link.  

3. Click the Marker button ( ) at the bottom of the Program view, choose Mark, and select a 

marker number.  

4. When the marker appears in the Timeline, double-click it to open the Marker dialog box.  

5. Type a comment in the Comment field.  

6. Type a duration in the Duration field for the amount of time you want the comment to display.  

Editing a clip in its original application 
 

The Edit Original command opens clips in their original application so that you can edit them and then 

have those changes automatically incorporated into the current project without exiting Premiere or 

replacing files. Exported Premiere movies can also be embedded with information that allows them to be 

opened using the Edit Original command that is in other applications, such as Adobe After Effects. 

 

To edit a clip in its original application: 
1. Select a clip in either the Project Window or the Source View of the Monitor Window.  

2. Choose Edit > Edit Original. 

Changing clip duration and speed 
 

The duration of a video or audio clip is the length of time it plays--the difference in time between a 

clip's In point and Out point. The initial duration of a clip is the same as it was when the clip was 

imported or captured. If you alter the beginning and ending of a clip by editing the source In and Out 

points, its duration changes. You can also set the duration of a clip by specifying a length of time from 

its current source In point. A still image can also have a duration if you want to display it for a specific 

length of time. You can set the default duration of the still images you import. 

The speed of a clip is the playback rate of the action or audio compared to the rate at which it was 

recorded. Speed is initially the same as it was when the clip was imported or captured. Changing a clip's 

speed alters its source frame rate and may cause some frames to be omitted or repeated. In addition, 

changing the speed of a clip requires playing the same number of frames for a different length of time, 

which also changes the duration (moves the Out point) of the clip. Changing the speed to a negative 

value (such as -100) causes the clip to play in reverse. When you change the speed of a clip containing 

interlaced fields, you may need to adjust how Premiere treats the fields, especially when the speed drops 

below 100% of the original speed. 
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Changing the frame rate of a clip 
 

You can change the number of frames displayed per second for a clip by specifying its frame rate. You 

may want to change the frame rate of a video file to decrease its frame size or make it match the rate of 

other clips in your project. Changing the frame rate does not change the speed of action, unless you use 

the Interpret Footage command, which changes both the frame rate and the speed of action. When you 

specify a frame rate lower than that at which the clip was shot or lower than the project frame rate, there 

aren't enough source clip frames to match the project frame rate, and movement may appear jerky. In 

this situation, Premiere makes up for the missing frames by repeating the last available source frame 

until the next new source frame is available. However, you can apply frame blending, which interpolates 

between available frames to create intermediate frames that can make motion seem smoother. Frame 

blending is also useful after changing clip speed, which also changes the frame rate. 

Maintaining the original aspect ratio of a clip 
 

A project can contain clips that have varying aspect ratios (proportions of height to width). The aspect 

ratio of a project is determined by the frame size you specify in the Project Settings or Export Settings 

dialog boxes. When a clip in the Timeline uses an aspect ratio that is different from the project aspect 

ratio, Premiere stretches the clip to match the aspect ratio of your project. However, this distorts the 

picture; resolve this problem by maintaining the clip's original aspect ratio. When you maintain the 

aspect ratio of a clip with a different aspect ratio from the frame, two sides touch the edge of the frame 

and empty space appears outside the other two sides, similar to how letterboxed wide-screen videos 

appear on a television. You can specify the color for the empty areas. 

Editing a video program 
 

You can edit a program in the Monitor window using the source and program controllers to enter 

timecode, or you can edit visually in the Timeline. Some time-based edits are easier in the Timeline, 

where you can adjust In and Out points and duration by clicking and dragging. By zooming in on the 

Timeline, you can edit individual frames with the mouse. By zooming out, you can quickly make large 

changes 

Cutting and pasting clips and clip settings 
 

You can rearrange existing clips in the Timeline by cutting and pasting. If you simply paste a clip, 

Premiere inserts it at a selected area in the Timeline by either trimming the clip's Out point to allow it to 

fit into a gap between two other clips or placing the entire clip. If you want another result, you can 

control exactly what happens to the clips at the edit point when you paste. This kind of control is most 

useful when you are pasting a clip of one duration into a selected space of a different duration. 

If you have applied settings to a clip and want to use the same settings in another clip, you can easily 

copy the settings. For example, you might want to apply identical color correction to a series of clips 

captured in the same session. 

Deleting space between clips 
 

Quickly delete empty space between clips on a track using the Ripple Delete command.  
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To delete empty space between clips: 

Select the empty space, and choose Timeline > Ripple Delete. Once the space is deleted, all clips on the 

track shift to close the gap. 

Linking video and audio clips in the Timeline 
 

When you add a clip containing video and audio to the program, and you've specified adding both the 

video and audio portions, the video portion appears in a video track and the audio portion appears in an 

audio track. The video and audio portions of the clip are linked so that when you drag the video portion 

in the Timeline, the linked audio moves with it. If you split the clip, the video and audio are still linked 

within the two resulting clips. You can link video only to audio--you cannot link a video clip to another 

video clip. 

In many situations it is useful to link or unlink clips manually. For example, you might want to move 

previously unlinked audio or video clips together, or edit the In or Out point of the video or audio 

portion of a clip independently. You don't have to unlink clips if you only want to delete one clip or the 

other. 

Using the Trim view 
 

The Monitor window Trim view is a precise way to trim clips interactively in any video track. You can 

perform ripple or rolling edits at any edit along the Timeline. As you make adjustments, you see the 

frames on both sides of the edit. You can also set a range of frames you see on both sides of the edit to 

expand your view of the context of the edit. The Timeline updates as you perform the edit. 

When you're not in Trim view, the left monitor displays source clips and the right monitor displays the 

program. When you use the Trim view, both monitors represent clips in the program--the left monitor is 

the clip to the left of the edit line, and the right monitor is the clip to the right of the edit line. 

Using the Movie Capture window 
 

Use the Movie Capture window to capture DV and analog video and audio. This window includes a 

preview window, which displays your currently recording video, controls for recording with and without 

device control, a Settings panel for viewing and editing your current capture settings, and a logging 

panel for entering batch capture settings. You can log clips for batch capture only when using device 

control. You can set the preview area to the Fit in Window mode so that the video always fills the 

preview area. 

Note: When performing anything other than capturing in Premiere, close the Movie Capture Window. 

Because the Movie Capture window assumes primary focus when open, leaving it open while editing or 

previewing video disables output to the DV device and may decrease performance. 

Batch-capturing video 
If you have the proper setup for device control and have a videotape recorded with timecode, you can set 

up Premiere for automatic, unattended capture of multiple clips from the same tape. This is called batch 

capturing. You log, or create a list of, the segments you want to capture from the tape in the Batch 

Capture window. The list (called a batch list or timecode log) can be created either by logging clips 

visually using device control or by typing In and Out points manually. When the batch list is ready, click 

one button to capture the clips in the list. You can batch-capture clips from analog or DV camcorders or 

decks.  

 

www.a2zpapers.com
We provide GNDU question papers, PTU question papers, PU question papers, LPU question papers, GNA university question papers, PSEB question papers, HPSEB question papers, ICSE question papers and CBSE question papers.

a2zpapers.com

a2zpapers.com

a
2
z
p
a
p
e
r
s
.
c
o
m

a
2
z
p
a
p
e
r
s
.
c
o
m

a2zpapers.com

www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
a2zpapers.com
a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com


Page 13 of 44 
 

 

Preparing for DV video capture 
Capturing DV video differs from capturing analog video in several ways. Because the DV image is 

converted directly to digital format in the camcorder, it is ready to be stored on a hard disk and doesn't 

need to be digitized in the computer. Therefore, DV input doesn't need to be captured in the sense that 

analog video does; it merely needs to be transferred to your computer. To transfer DV in Windows or 

Mac OS, you need a capture card. 

Your computer also needs a DV codec, which is provided in software as part of the operating system, or 

as a hardware chip on some capture cards. Premiere includes support for DV codecs and can read digital 

source video without further conversion. You can help prevent dropped frames by using a hard disk 

capable of sustaining the 3.6-MB-per-second data rate of digital video.  

A critical difference between analog capture and digital capture is how you set up Premiere before you 

begin. Before capturing DV, create a new project, and in the Load Project Settings dialog box, be sure to 

choose the appropriate DV preset.  

Note: If the video you are capturing was shot in 16:9 format using an anamorphic lens, be sure to choose 

a Widescreen (cinema) DV preset. You'll also need to set the pixel aspect ratio for each individual clip 

after importing. If you don't, Premiere will treat the video as if it were in 4:3 format, resulting in 

distortion of the aspect ratio.  

Understanding offline and online editing 
 

Depending on the level of quality you require and the capabilities of your equipment, you can use 

Premiere for either online or offline editing when working with analog source material. The settings you 

specify for capture are dictated by whether you will edit the program offline or online.  

online editing 
Online editing is the practice of doing all editing (including the rough cut) on the same clips that will be 

used to product the final cut. Previously, online editing had to be done on expensive high-end 

workstations designed to meet the picture quality and data-processing requirements of broadcast-quality 

video. Editors with high-end requirements who could not afford a suitable online system had to rent time 

at a production facility that owned one. As high-end personal computers have become more powerful, 

online editing has become practical for a wider range of productions such as broadcast television or 

motion-picture film productions.  

For online editing, you'll capture clips once at the highest level of quality your computer and peripherals 

can handle. 

Offline editing 
In offline editing, you edit video using low-quality clips and produce the final version using high-quality 

clips on a high-end system. Offline editing was developed to save money by editing in a less expensive 

facility. Although offline editing can be as simple as writing down time points for scenes while watching 

them on a VCR, it is increasingly done using personal computers and Premiere.  

Offline editing techniques can be useful even if your computer can handle editing at the quality of your 

final cut. By batch-capturing video using low-quality settings, you can edit faster, using smaller files. 

When you digitize video for offline editing, you specify settings that emphasize editing speed over 

picture quality. In most cases you need only enough quality to identify the correct beginning and ending 

frames for each scene. When you're ready to create the final cut, you can redigitize the video at the final-

quality settings 
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ABOUT TRANSITIONS 
 

The visual change from one clip to another is called a transition. To add nuance, texture, or special effects 

between video clips, Premiere provides a variety of transitions, such as wipes, zooms, and dissolves. The 

simplest transition is the cut, where the last frame of one clip leads directly into the first frame of the next. 

The term comes from film editing, where a cut means splicing two shots together. Very often, a cut is the 

most effective way to move from one scene to the next. Other transitions, however, are useful in setting a 

mood or adding a creative element to your project. 

Transition Palette 
Premiere includes over 75 transitions, which you choose from the Transitions palette. Within the palette, 

transitions are organized by type, in folders. Each transition is represented by an icon depicting how it 

works, where A is the first clip and B is the second.  

To display the Transitions palette: 

Choose Window > Show Transitions. 

To view a description of a transition:  

1. Display the Info palette, if necessary: choose Window > Show Info.  

2. Select the transition in the Transitions palette. The description appears in the Info palette.  

To customize the Transitions palette: 

 To animate the icons, choose Animate from the Transitions palette menu.  

 To stop icon animation, deselect Animate from the Transitions palette menu.  

 To hide all transitions within a folder, click the triangle next to the folder name to collapse the 

folder.  

 To hide selected transitions, select one or more transitions in the Transitions palette (Shift-click 

to select multiple transitions), and then choose Hide Selected from the Transitions palette menu.  

 To restore hidden transitions, choose Show Hidden from the Transitions palette menu. The 

hidden transition appears dimmed. To restore the transition, select it and choose Show Selected 

from the Transitions palette menu.  

 To reorder a transition in the palette, drag the transition up or down to a new location in its 

folder, or into another folder.  

 To reorder a folder in the palette, drag the folder to a new location. With large folders, collapse 

the folder first.  

 To create a new folder, click the New Folder button () or choose New Folder from the 

Transitions palette menu, type a name, and click OK. Drag transitions to the new folder.  

 To rename a folder, select it, choose Rename Folder from the Transitions palette menu, type a 

name, and click OK.  

 To delete a custom folder, select it, click the Delete Selection button () or choose Delete Folder 

from the Transitions palette menu, and click Yes. The folder is removed, and all included files 

are placed in their original folders and dimmed. 

Note: If you delete a default folder, the folder and all its contents are dimmed. 
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 To find a transition, click the Find button () or choose Find from the Transitions palette menu, 

type the name of the transition, and click Find. To find the next instance, click Find Again.  

 To expand all the folders in the palette so you can view all the transition names, choose Expand 

All Folders from the Transitions palette menu.  

 To collapse all the folders in the palette to preserve space or clean up the palette, choose 

Collapse All Folders in the Transitions palette menu. 

Working in the A/B Editing workspace 

When you are working in the A/B Editing workspace or the Timeline is in A/B Editing mode, the Timeline 

uses three separate Video 1 tracks: Video 1A, Transition, and Video 1B. With this layout. you can visually 

determine the position and duration of a transition between two overlapping clips.  

To add a transition to the Video 1 track in the A/B Editing workspace: 

1. Position one clip in the Video 1A track and another clip in the Video 1B track so that some (or all) of the 

two clips overlap. The amount of overlap determines the default size of the transition.  

2. If the Transitions palette is not visible, choose Window > Show Transitions.  

3. Select and drag a transition from the Transitions palette to the Transition track in the Timeline window, 

between the overlapping area of the two clips. The duration of the transition is automatically adjusted to 

the overlapping area. 

Changing transition settings 
You can change a number of settings for each transition, including the transition direction, the start and end 

values, the border, and anti-aliasing. The following procedure describes how to display the Transition 

Settings dialog box and change settings common to many transitions. Settings specific to transitions are 

available by clicking Custom in the Transition Settings dialog box. 

To change transition settings: 

1. Open the Transition Settings dialog box in one of the following ways:  
 To change the settings for a single instance of the transition in the video program, in the 

Timeline either double-click the transition or select the transition and choose Timeline > 

Transition Settings.  

 To change the default settings of a transition for this and future projects, double-click the 

transition in the Transitions palette. 

2. Adjust any of the following settings, and then click OK:  
 To see the starting and ending frames of the clips, select Show Actual Sources. This option is not 

available when you've double-clicked a transition in the Transitions palette.  

 To change the initial and final appearance of the transition, use the Start and End sliders. (For 

example, if you want to create a picture-in-a-picture effect, use the Zoom transition and set the 

start and end sizes to about 30%; then add a border and move the center point to the desired 

corner.) Hold down the Shift key to move the start and end sliders together (for example, to set 

the start and end size of the transition to 30%).  

 To adjust the width of the optional border on the transition, drag the Border slider. The default 

Border is None. Some transitions do not have borders.  

 To select a border color, click the color swatch, select a color from the color selection window, 

and then click OK.  
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 To specify which clip begins the transition, click the Track selector on the left side of the 

transition's thumbnail to toggle back and forth starting with clip A (the left clip) or clip B (the 

right clip). You can also click this selector from the transition's thumbnail in the Timeline 

window if the thumbnail is large enough.  

 To change the orientation of the transition, click an Edge selector on the transition's thumbnail. 

The Edge selectors are small triangles bordering the transition icon.  

For example, the Barn Doors transition can be oriented vertically or horizontally. Some transitions do 

not have Edge selectors because the transition has only one orientation.  

 To make the transition play forward or backward, click the Forward/Reverse selector in the 

upper right corner of the transition's thumbnail. For example, the Clock Wipe transition can play 

clockwise or counterclockwise.  

 To adjust the smoothness of the transition's edges, click the Anti-aliasing selector in the lower 

right corner of the transition's thumbnail. Clicking cycles through the values Low, High, and Off. 

Anti-aliasing smooths the edges or borders of the transition, improving its quality. You can also set anti-

aliasing from the transition's thumbnail in the Timeline window. 

 To adjust the center point of the transition, drag the small box that appears in the Start and End 

images. For example, the Iris Round transition can be centered toward the side or corner of the 

image.  

 To change settings specific to the transition, click Custom. (Transitions without additional 

controls do not include a Custom button.)  

Replacing a transition 

You can replace a transition by simply dropping a new transition on top of the old one. When you replace a 

transition, the alignment and duration are preserved; however, the settings for the old transition are 

discarded and replaced by the default settings for the new transition.  

To replace a transition:  

Drag the new transition from the Transitions palette onto the existing transition in the Timeline window.  

Setting up Premiere's scratch disks 
 

When you edit a project, Premiere processes your changes in RAM. When the available RAM isn't enough, 

Premiere can use hard disk space as an additional work area. Also, Premiere stores some project information, 

such as preview files, on your hard disk, using the disk the same way you would use a paper scratch pad. If your 

system has access to multiple volumes (disks or disk partitions), you can specify which one Premiere uses as a 

scratch disk for the different temp files it creates when capturing movies, building video previews, and building 

audio previews. The scratch disk space Premiere uses increases as a program becomes longer or more complex. 

For maximum performance, follow these tips: 

 

-  Store Premiere and the operating system on one hard disk, and capture video to an additional AV-certified 

hard disk on which nothing else is stored. Save and store your project on the same hard disk as Premiere 

(preferably the system disk).  

-  Specify your fastest hard disk for video preview files and capturing. You can use a slower disk for audio 

preview files. Ideally, you want your video and audio preview files on different disks to reduce the amount of 
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activity necessary for playback. Two partitions on the same disk do not improve playback--you must use two 

physically different disks.  

  Specify only disks attached to your computer--a hard disk located on a network is usually too slow. 

Removable media may be acceptable if it is fast enough 

Creating a text list of project files 
 

To document the contents of a project, you can export a text file that lists all the clips used in a project. The list 

displays the original filenames of clips, bins, and bin contents in the order in which they appear in a Project 

window. If a Bin window is active when you export, Premiere exports a file list for the project that includes the 

bin and its contents. In Windows, the file list contains the pathname to the file.  

Using the Project window's bin view 
 

A Project window includes a bin view, which shows the bins that have been added to the project. The bin view 

appears on the left side of the Project window, and can be resized or hidden. When the bins in the bin view 

contain other bins, the hierarchical structure appears, much like the graphical view of folders and subfolders in 

your operating system. 

Story boarding

 
Every Project needs a Plan. If you are simply shooting video and then capturing the footage in your 

computer for a home project, you may get by without a plan. Storyboards can be as simple as hand drawn 

sketches on a note pad, extremely graphically detailed set of illustration 

Animating a clip's motion 

 
Animate a clip by creating a motion path in the Motion Settings dialog box. You can specify the path 

completely within the visible area, or extend it beyond so that the clip enters and exits at the boundaries. 

Note that you can add motion only to the clip itself, as a whole; you cannot add motion to elements within 

the clip. In addition, you can specify rotation, zooming, delays, and distortion to create more complex 

motion. 

For each motion keyframe on the path, you can set values for rotation, zoom, and delay, and define a 

shape for distorting the clip. By specifying different values at different motion keyframes, you can 

rotate, zoom, delay, and distort the clip over time. 

Enabling and disabling clips 
 

Disabled clips do not appear in the Monitor Program view and will not appear in a preview or video file that 

you export. You can disable clips in the Timeline. This is useful if you want to suppress clips while you try out 

a different editing idea, to shorten processing time when working on a complex project, or to exclude a clip 

from an EDL you export. If you have not locked a disabled clip, you can still make changes to it. If you want to 

disable all clips on the same track, exclude the entire track instead; see Customizing track views. 

To enable or disable a clip: 
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Select one or more clips in the Timeline, and choose Clip > Enable Clip on Timeline. A check mark next to 

the command indicates that the selected clip is enabled. Disabled clips are marked by a hatch pattern 

of backslashes. 

Using the Commands palette 
 

The Commands palette comes with a list of preset commands, which you can modify to suit your needs. 

You can create a custom set of buttons for fast access to your favorite menu commands, and assign a 

function key to each button for instant keyboard access. 

Using the History palette 
 

Use the History palette to jump to any state of the project created during the current working session. Each 

time you apply a change to some part of the project, the new state of that project is added to the palette. 

Using the Navigator palette 
 

Use the Navigator palette to quickly change your view of the Timeline by dragging a view box within a 

miniature representation of the Timeline. You can also change the level of detail displayed in the Timeline. 

Using window and palette menus 
 

In Premiere, most windows and palettes include menus that can be displayed by clicking a button. In addition, 

all windows also have context menus, the content of which depends on the current task or mode. The commands 

found in window menus, palette menus, and context menus are specific to individual windows or palettes. 

Using the Info palette 
 

The Info palette displays information about a selected clip or transition. If you drag a clip in the Timeline, you 

can watch the starting and ending time change in the Info palette. The information displayed in the palette may 

vary depending on factors such as the media type and the current window. For instance, an empty space in the 

Timeline, a rectangle in the Title window, and a clip in the Project window display information unique to each 

item when selected. 

ADOBE TITLE DESIGNER 
 

In Premiere 6.5, you have the ability to design complex titles with the Adobe Title Designer. With the 

Adobe Title Designer, you can add a variety of attributes to titles, use various templates to design titles, 

freely manipulate shapes in a title, and create custom styles that you can save and use with other title 

documents. 

Opening a new or saved title 

Even though you can create a title while working in a project, a title is an independent file, separate from 

your project. Like any other clip, it doesn't become part of your video program until you add it to the 

Timeline. You can work with more than one open Adobe Title Designer window at a time, and use a title in 
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more than one project. New titles saved from the Adobe Title Designer appear in the active bin in the 

Project window. 

To start and save a new title: 

1. Choose File > New > Title. The Adobe Title Designer opens.  

2. Choose File > Save As.  

3. Specify a location and filename, and then click Save. 

To open a previously saved title: 

1. Choose File > Open.  

2. Select a title and click Open.  

Note: You can only open titles created in Premiere 6.5 in the Adobe Title Designer. When you open 

titles created in Premiere 6.0 and earlier, the Premiere 6.0 Title window opens. You may either continue 

to work in the 6.0 Title window, or you can copy and paste the title text into the Adobe Title Designer.  

To edit a title in an open project: 

Double-click the title in the Project window or the Timeline. 

Showing video behind the title 
If you are creating a title for a specific piece of footage, it may be useful to view a frame of that footage in 

the drawing area as you create the title. Displaying footage is helpful if you want to precisely position a title 

or compare title and footage colors. Use Adobe Title Designer's timecode controls to target and display a 

specific frame from the Timeline. Use the Sync to Timeline button to display the frame at the edit line in the 

Timeline and update the timecode to reflect the frame's location on the Timeline. 

To show a frame of video behind the title: 

In the Adobe Title Designer window, select Show Video. 

Creating rolls and crawls 
Though static titles, graphics, and logos, may suffice for some projects, many others require titles that move 

across the footage. Titles that move vertically over the footage are called rolls. Titles that move horizontally 

are called crawls. The Adobe Title Designer provides choices and settings that facilitate creating smooth, 

expert rolls and crawls.  

Note: The length of the title in the Timeline window determines the speed of the roll or crawl. The more you 

increase the title clip length, the slower the scroll. 

Understanding safe title and safe action margins 

The safe title and action margins in the Adobe Title Designer drawing area designate the title's visible safe 

zones. You can set display options for these zones in the Titler preferences dialog box.  

Safe zones are useful when editing for broadcast and videotape. Most consumer television sets use a process 

called overscan, which cuts off a portion of the outer edges of the picture, allowing the center of the picture 
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to be enlarged. The amount of overscan is not consistent across televisions, so to ensure that everything fits 

within the area that most televisions display, keep text within the title safe margins, and all other important 

elements within the action safe margins. For best results, preview your video on a television monitor 

connected to your computer. 

Working with the pen tool 
The Adobe Title Designer includes standard pen tools that resemble those used in graphic design 

applications such as Adobe Illustrator and Adobe Photoshop. Use the pen tools to create an object of any 

shape, including straight lines at any angle or smooth flowing curves.  

Adding a title to a project 
When you've completed and saved a title, Premiere automatically adds it to the open Project window. The 

title becomes a clip in the project, using the original title file as its source. 

If you want the title to display with transparency so you can superimpose it over another clip, add the title to 

a superimposition track. When you add a title to a superimposition track, empty and semitransparent areas 

of the title are converted into an alpha channel, which marks transparent and semitransparent areas. 

Premiere automatically applies the Alpha Channel transparency key to titles, making any mattes or clips on 

lower tracks visible under the title. Titles added to the Video 1A or 1B tracks appear opaque by default.  

To add a title to a project: 

1. Save the title. The title appears in the open Project window.  

2. Do one of the following:  

 To superimpose the title over another clip, add it to a superimpose track (Video 2 or higher).  

 To make the title appear opaque, add it to the Video 1A or 1B track. 

Note: If you add a title to the Video 1A or 1B track and then move it to a superimposition track, it 

appears opaque. To make it transparent, select the title, choose Clip > Video Options > Transparency, 

and choose an appropriate key type from the menu. 

To change the duration of a title in the Timeline: 

Do one of the following: 

 Drag its In or Out point.  

 Select it, choose Clip > Duration, and type a new duration. 

To preview a title: 

Do one of the following: 

 Render-scrub the portion of the Timeline that you want to view: press Alt (Windows) as you 

drag in the time ruler over the frames that you want to view.  

 Build a preview of the title: in the Timeline, move the yellow work area bar so that it covers the 

portion of the Timeline containing the title, and then press Enter (Windows) to build a preview 

file. Use the new software real-time preview for faster previews.  
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ABOUT TRANSPARENCY 
 

In video or film, transparency allows one clip to show through another, creating composites, transitions, 

or special effects. The opacity of a clip or portion of a clip determines its level of transparency. At 100% 

opacity, an image contains no transparency at all; at 0% opacity, the image is completely transparent, 

allowing other clips to show through. At other percentages, the image is partially transparent, allowing 

other underlying images to be visible at the same time. The brightness values of a clip's alpha channel, 

an additional grayscale or monochrome channel in an RGB image, also determine the clip's opacity. 

Compositing 
Special effects for film or video are often created by shooting a scene against a color screen. After the 

footage is digitized, the color screen is then made transparent with a key. The first scene, or clip, is 

placed over a second clip, which usually includes some sort of background scene. The result forms a 

composite, where the background is visible wherever the first clip is transparent, making the first clip 

appear to belong with the background. 

Composites are often used in feature films where, for example, an actor appears to dangle from a 

helicopter or appears to be floating in outer space. In this case, the actor is shot in an appropriate 

position against a color screen, and after making the color transparent, the actor's scene is superimposed 

over the backdrop. Color screens are usually blue or green because these colors are relatively absent 

from skin or hair color. 

Fading 
In addition to making portions of a clip transparent with keys, you can also adjust the opacity of the 

entire clip to fade it in or out. You can use fading to create additional transitional effects or to create 

simple superimposing.  

       Using the Video Opacity rubberband 
When you place a clip in a superimpose track, an Opacity rubberband, appears beneath it (you must 

expand the superimpose track to display the Opacity rubberband). The Opacity rubberband specifies the 

opacity of the entire clip. By adding handles, you can adjust the opacity of a clip. 

The Opacity rubberband adjusts opacity after any keys have been applied. In other words, moving 

the Opacity rubberband adjusts the opacity for opaque, transparent, and semitransparent regions in the 

clip. 

Using the Chroma key type 
Use the Chroma key to select a color or a range of colors in the clip to be transparent. You can use this 

key when you have shot a scene against a screen that contains a range of one color, such as a shadowy 

blue screen. Select a key color by clicking the color swatch or by using the eyedropper to choose a color 

from the thumbnail beneath the color swatch; use the slider bars in the dialog box to adjust the color that 

you want to key out.  

Adjust the following Chroma key settings as necessary: 

Similarity 

Broadens or reduces the range of color that will be made transparent. Higher values increase the range. 

Blend 

Blends the clip you are keying out with the underlying clip. Higher values blend more of the clip. 

Threshold 

Controls the amount of shadows in the range of color you keyed out. Higher values retain more 

shadows. 

Cutoff 
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Darkens or lightens shadows. Drag to the right to darken shadows, but do not drag beyond the Threshold 

slider; doing so inverts gray and transparent pixels. 

Smoothing 

Specifies the amount of anti-aliasing that Premiere applies to the boundary between transparent and 

opaque regions. Anti-aliasing blends pixels to produce softer, smoother edges. Choose None to produce 

sharp edges, with no anti-aliasing. This is useful when you want to preserve sharp lines, such as those in 

titles. Choose Low or High to produce different amounts of smoothing. 

Using the RGB Difference key 
The RGB Difference key is a simpler version of the Chroma key. You can select a range of color, but 

you cannot blend the image or adjust transparency in grays. Use the RGB Difference key for a scene that 

is brightly lit and contains no shadows, or for rough cuts that don't require fine adjustments. Select a key 

color by clicking the color swatch or by using the eyedropper to choose a color from the thumbnail 

beneath the color swatch. 

Using the Blue Screen and Green Screen keys 
The Blue Screen and Green Screen keys create transparency from true chroma blue and true chroma 

green. Use these keys to key out well-lit blue or green screens when creating composites.  

Adjust the following Blue Screen and Green Screen key settings as necessary: 

Threshold 

Drag to the left until the blue or green screen is made transparent. 

Cutoff 

Drag to the right until the opaque area reaches a satisfactory level.  

 

Using the Non-Red key 
The Non-Red key creates transparency from green or blue backgrounds. It is similar to the Blue Screen 

and Green Screen keys, but it also lets you blend two clips. In addition, it helps reduce fringing around 

the edges of nontransparent objects. The Non-Red key is recommended for keying out green screens 

when you need to control blending, or for when you are not able to produce satisfactory results with the 

Blue Screen or Green Screen keys. 

 

Using the Luminance key 
The Luminance key creates transparency for darker values in the image, leaving brighter colors opaque. 

Like the Multiply and Screen keys, it is most effective when the image that you are keying contains 

highly contrasting dark and light areas. Use the Luminance key to create a subtle superimposition or to 

key out dark areas. 

Adjust the following settings as necessary: 

 

Using the Multiply and Screen keys 
The Multiply and Screen keys use an underlying image as a map to determine what part of the keyed 

image to make transparent. The Multiply key creates transparency in the areas of the image that 

correspond to the bright areas in the underlying image. Conversely, the Screen key creates transparency 

in the areas that correspond to the dark areas of the underlying image. Use these keys to create a subtle 

superimposition, when the underlying image contains highly contrasting elements. 

 

 

www.a2zpapers.com
We provide GNDU question papers, PTU question papers, PU question papers, LPU question papers, GNA university question papers, PSEB question papers, HPSEB question papers, ICSE question papers and CBSE question papers.

a2zpapers.com

a2zpapers.com

a
2
z
p
a
p
e
r
s
.
c
o
m

a
2
z
p
a
p
e
r
s
.
c
o
m

a2zpapers.com

www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
a2zpapers.com
a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com


Page 23 of 44 
 

Using the Alpha Channel key 
Images represented on video are composed of three grayscale images called channels--one red, one 

green, and one blue. Such images are called RGB images. An alpha channel is a fourth channel in an 

RGB image that defines what parts of the image are transparent or semitransparent. Many programs, 

such as Adobe Illustrator and Photoshop, use alpha channels so that you can specify transparent regions 

in an image. An alpha channel is either straight or premultiplied, depending on the program that created 

the image. When an image contains a straight alpha channel, the transparency information is stored only 

in the alpha channel. When an image contains a premultiplied alpha channel, the background color that 

is intended to be transparent is also blended into the edges of an image. Use the Alpha Channel key on 

clips that contain a straight alpha channel, such as images created in Adobe Photoshop, Adobe 

Illustrator, and Adobe After Effects. 

 

Using Black Alpha Matte and White Alpha Matte keys 
Typically, an image that contains a premultiplied alpha channel also contains either a black or white 

background. If you are superimposing the image, you likely need to key out the background. 

To key out a black background, use the Black Alpha Matte; to key out a white background, use the 

White Alpha Matte.  

Image Matte 
The Image Matte key uses a specified still image (the matte) to determine the areas of transparency for a 

clip. Areas in the superimposed clip that correspond to areas of white in the still image remain opaque, 

areas of black in the still image become fully transparent in the clip, and areas in the image that are 

between white and black produce varying levels of transparency in the clip.  

To get the most predictable results, choose a grayscale image for your image matte, unless you want to 

alter colors in the clip. Any color in the image matte removes the same level of color from the clip you 

are keying. For example, white areas in the clip that correspond to red areas in the image matte will 

appear blue-green (since white in an RGB image is composed of 100% red, 100% blue, and 100% 

green); because red is also made transparent in the clip, only blue and green colors would remain at their 

original values. 

 

Difference Matte 
The Difference Matte creates transparency by comparing a specified image with a specified clip and 

then eliminating areas in the clip that match those in the image. Though you can use this key to create 

special effects, you can also use it to key out a static background by selecting the Reverse Key option. 

In this way, you can remove a static background behind a moving object (such as a person walking past 

a stage set), and place the person against a different background. Very often the specified image is 

simply a frame of background footage (before the moving object has entered the scene). For this reason, 

the Difference Matte is best used in this way for scenes that have been shot with a stationary camera.  

 

Track Matte 
Use the Track Matte key to create a moving matte (often called a traveling matte), which superimposes 

one clip on another using the matte to integrate the two. You can use any clip, still image, or still image 

with motion for the matte. 
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Because the Track Matte key can be applied to a video clip, the matte can change over time. 

Areas of white in the matte create opaque areas in the superimposed clip, preventing underlying clips 

from showing through. Black areas in the matte create transparent areas, and gray areas make partially 

transparent areas. To retain the original colors in your superimposed clip, use a grayscale image for the 

matte. Any color in the matte removes the same level of color from the superimposed clip.  

Superimposing two or more clips 
 

You can superimpose several clips one on top of another in up to 97 superimpose tracks. Each clip must 

be on a separate superimpose track. You can also rename each track with descriptive names 

EFFECTS 
 

You can add any effect to a clip at any time. If you don't like an effect, you can easily delete it. You can 

even apply the same effect multiple times to the same clip with different settings. For example, you can 

add multiple instances of the Equalize audio effect for situations when you would chain together 

multiple equalization hardware modules in a conventional audio studio. 

By default, when you apply an effect to a clip, the effect is active for the duration of the clip. However, 

you can make the effect start and stop at specific times, or make the effect more or less intense over 

time, by using keyframes.  

Understanding keyframes 
Premiere uses keyframes to change an effect over time. A keyframe contains the values for all the 

controls in the effect and applies those values to the clip at the specified time. By default, once you 

apply an effect to a clip, Premiere creates a beginning and ending keyframe with the same value, but by 

applying different values to keyframes, you can change an effect over time. Premiere automatically 

interpolates the values of the controls between the keyframes, using a linear progression. This means 

that you don't have to create a keyframe for every frame in the clip. 

For example, suppose that you wanted to use the Crystallize effect and have it increase and then 

decrease over time. In this case, you would need to set three keyframes--the first with light 

crystallization, the second with more significant crystallization, and the third with light crystallization. 

Because Premiere automatically interpolates the distortion between each keyframe, the crystallization 

will gradually increase (linearly) between the first and second keyframes and then gradually decrease 

between the second and third keyframes. 

 

Keyframe navigator 
After you set the initial keyframe for a clip, and if the keyframe button is pressed, Premiere displays the 

keyframe navigator, which you can use to move from keyframe to keyframe or to set or remove 

keyframes. A checkmark in the keyframe navigator box indicates that the edit line lies precisely at a 

keyframe for that clip. When the box contains no checkmark, the edit line lies between keyframes. 
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Effect Enabled button 
When you create a keyframe for an effect, a stopwatch icon ( ) appears in the Effect Enabled button 

next to the effect name in the Effect Controls palette. Once the stopwatch appears for a specific effect, 

Premiere automatically sets new keyframes whenever you move the edit line and change the effect's 

controls. Clicking the Effect Enabled button again, which removes the stopwatch, deletes all keyframes, 

except the default keyframes. Setting a value for an effect control when the stopwatch has been removed 

modifies the default (first and last) keyframes, and that value remains in effect for the duration of the 

clip. 

 

Working with effects 
 

When you apply an effect to a clip, the effect is listed in the Effect Controls palette. The effect is also 

listed directly above the clip's keyframe line. If a clip has multiple effects applied, the effect pop-up 

menu lists them and they are rendered in order from top to bottom in this list. You can reorder the 

effects in this list to change which effects are rendered first.  

Using the Audio and Video Effects palettes 
All effects are stored in the Audio or Video Effects palette, which you can customize to best suit your 

working style. Effects are grouped by type; for example, all video effects that create a blur are listed in a 

Blurs folder in the Video Effects palette. You can hide effects that you don't use and create new folders 

containing special groups of commonly used effects or rarely used effects. 

 

       Understanding how Premiere processes audio 
You can process an audio clip in several ways: adjusting volume and pan/balance levels (either directly 

in the Timeline or by using the Audio Mixer window), choosing a menu command for a selected clip, or 

applying an audio effect. Understanding the order in which Premiere processes audio can help you plan 

audio adjustments.  

When you preview, play, or export a video, Premiere first converts its audio (one frame at a time) using 

the settings you specify in the Audio Settings dialog box. If you selected stereo as one of the audio 

settings, additional stereo commands located in the Clip > Audio Options menu (such as Duplicate Left 

or Mute Right), are then processed. Audio effects you have applied are processed next, followed by any 

pan/balance or volume adjustments in the Timeline audio track for the clip. Finally, Premiere processes 

any gain adjustments you applied using the Clip > Audio Options > Audio Gain command.  

 

       Adjusting gain 
You can set the overall gain of a clip. Although your gain setting is processed after volume, pan/balance, 

and effects are processed, it will not remove any of these settings. Setting the gain is useful to balance 

the gain levels of several clips or to adjust a clip's audio signal when it is too high or too low. Keep in 

mind, however, that if the gain in an audio clip was set too low when it was digitized, increasing the 

gain may emphasize noise or introduce distortion. For best results, follow the standard practice of 

making sure that the gain level is correct at the time the audio clip is digitized. 

Adjusting audio levels in the Timeline 
The red volume rubberband allows precise adjustment of the volume level at any point during the clip. 

Specify the adjustment point by creating a handle on the rubberband. A handle marks the beginning and 

ending of a rubberband segment, and you can drag the handle up or down to change the audio level. All 

audio clips include two handles that you can't remove--one at the beginning of the clip, and another at 

the end. You can also cross-fade two audio clips automatically so that one fades out as another fades in. 
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The rubberband in the Timeline corresponds to the volume fader in the Audio Mixer window, and serves 

the same purpose. The way you create fades in these two windows differs, however. In the Timeline, 

you visually adjust levels. In the Audio Mixer window, you adjust levels in real time as you listen to the 

track. Also, for each track in the Timeline, there is one volume rubberband per clip, while in the Audio 

Mixer window, there is one volume fader per track. 

 

Panning or balancing a clip 
You can pan a monophonic audio clip to set its position between the left and right stereo channels. For 

example, if an audio clip contains one person's dialogue, you can pan the audio to match the person's 

position in the frame.  

You cannot pan a stereo audio clip because both channels already contain audio information. When you 

work with a stereo audio clip, the pan control adjusts the balance of the stereo channels within the clip.  

Working with the Audio Mixer window 
In the Audio Mixer window, you can adjust the volume level and pan/balance of multiple audio tracks 

while listening to them and viewing the video tracks. Premiere uses automation to record these 

adjustments and then to apply them as the clip plays back. The Audio Mixer window, like an audio 

mixing console, contains a set of controls for each audio track, which is numbered according to the 

corresponding audio track in the Timeline. Using the mouse, drag a tracks's volume fader to adjust its 

volume over time. As you make adjustments using the Audio Mixer window, Premiere creates handles 

in the audio clip's volume rubberband in the Timeline and applies your changes.  

 

Adjusting audio levels in the Audio Mixer window using 

automation 
Using automation in the Audio Mixer window, you can set audio track levels and pan/balance tracks in 

real time as you listen to the audio track. Once the adjustments have been applied, fine-tune your 

changes directly in the Timeline by dragging the handles on the Volume rubberbands in each clip.  

Note: Audio Mixer window tracks are not functional when playing back segments of Timeline audio 

tracks containing previews. The Master Fader, however, remains functional. Use the Audio Mixer 

before applying audio effects that may cause preview files to be created. 

 

Using a clip's left or right stereo channel only 
Use the Duplicate Left and Duplicate Right commands to replace an entire audio clip with its left or 

right channel only. For example, you can create a full, balanced audio clip from a clip originally 

recorded only in the left or right stereo channel. 

 

Applying and controlling effects 
You can apply a video effect to a video clip in the Video 1 track and in any superimpose track. You can 

also apply an audio effect to any audio clip in the Timeline window. Clips that have effects applied to 

them appear with a blue border at the top in the Timeline window. 

You can apply or remove an effect at any time. Once you've applied effects to a clip, you can 

temporarily turn off one or all of the effects in the clip to concentrate on another aspect of your project. 

Effects that are turned off do not appear in the Program window and are not included when the clip is 

previewed or rendered. Turning off an effect does not delete the keyframes created for any of the effect's 

settings; all keyframes remain until the effect is deleted from the clip. 
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Exporting 
 

About exporting video from Premiere 
The program you've edited in the Timeline is not available as an independent video file until you export it. 

After export, you can play it in other video playback or editing programs and move it to other disks or 

platforms. Before export, make sure that the Timeline is ready to output at the quality you require. For 

example, replace any offline files with high-resolution files suitable for final export. You can also export 

from the Source or Program views or the Storyboard or Clip windows, and you can specify a range of 

frames to export. 

File types available for export 
You can export a video program directly to videotape, or to a variety of video, audio, or still-image file 

formats. In addition to Premiere's Movie Export options (File > Export Timeline > Movie, or File > Export 

Clip > Movie), you can use any of the following plug-in options: Save for Web, Advanced Windows Media 

(Windows only), or Advanced RealMedia Export. For detailed information on these plug-ins, see the plug-

in's online Help, or visit the plug-in manufacturer's Web site. The following file formats are available when 

you export. Additional file formats may be available in Premiere if provided with your video-capture card or 

if you have added separately available plug-in software. 

Video formats 

Microsoft AVI, Animated GIF, QuickTime, MPEG, Real Media, Windows Media 

Audio-only formats 

AIFF, MP3, and Windows Audio Waveform (Windows only) 

Progressive downloadable video 
A progressive download movie (also called a hinted movie) can begin playing before it is completely 

downloaded. The movie player (for example, QuickTime, Media Player, or Real Player) begins playback 

when it calculates that the movie will be fully downloaded by the time playback reaches the end of the 

video.  

The following downloadable video formats are available for export from Premiere: QuickTime Progressive 

Download, Windows Media, RealVideo, and RealG2 Web Download. You can create progressive download 

video using any of the Web export plug-ins: Save for Web, Advanced RealMedia Export, or Advanced 

Windows Media Export (Windows only). 

MPEG video 
Motion Picture Experts Group (MPEG) is a file format that compresses video files effectively but is not as 

standardized as QuickTime or AVI. There are actually several variations of MPEG. The version generally 

used for Internet and CD-ROM is MPEG-1, which provides picture quality nearly comparable to VHS. 
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MPEG-2 can provide SVHS picture quality. However, the keyframe-based compression and variable bit rate 

that make MPEG popular for delivery of final video require significant processing time.  

You can create MPEG video using the Save for Web export option. 

MP3 audio 
Motion Picture Experts Group (MPEG) 1 Layer 3 is a file format that compresses audio files at a 1:24 to 1:5 

ratio. The high compression rate makes MP3 files smaller and of higher quality than most other audio 

formats.  

You can create MP3 audio files using the Save for Web export option. 

Animated GIF 
Animated GIF is best suited for solid-color motion graphics at a small frame size, such as an animated 

company logo. It works better for synthetic graphics than for live-action video. It is convenient because it is 

viewable in most Web browsers without requiring a plug-in, but you cannot include audio in an animated 

GIF file. Export animated GIF the same way you do any other file, making sure that you choose Animated 

GIF as the File Type For best results, test completed Animated GIF files in a Web browser before 

distributing. 

Exporting a sequence of still images 
You can export a clip or program as a sequence of still images, with each frame in a separate still-image file. 

This can be useful to move a clip to animation and three-dimensional applications that do not import video 

file formats, or for use in animation programs that require a still-image sequence. When you export a still-

image sequence, Premiere numbers the files automatically. 

To export a series of still images: 

1. Choose File > Export Timeline > Movie.  

2. Click Settings.  

3. For File Type, choose a still-image sequence format (generally any file type ending in the word 

"sequence" and the FLC/FLI (Windows only) file type).  

4. Choose the frames to export from the Range menu.  

5. Make sure that Export Video is selected.  

6. Click Next and confirm video settings . 

7. Click Next. In the Keyframe and Rendering Options panel, specify options as needed, and then click 

OK.  

8. Specify a location where you want to export all of the still-image files. It's usually best to specify an 

empty folder set aside so that the sequence files don't become mixed with other files.  

9. If you want, type a numbered filename. To specify the number of digits in the filename, determine how 

many digits will be required to number the frames, and then add any additional zeroes you want. For 

example, if you want to export 20 frames and you want the filename to have five digits, type Car000 for 

the first filename (the remaining files will automatically be named Car00001, Car00002, ..., Car00020).  

10. Click OK to export the still-image sequence. 
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Exporting a still image 
You can export any frame or still-image clip to a still-image file. The frame is exported from the current 

time position in the Timeline, Clip window, Source view, or Program view. 

To export a still image: 

1. Choose File > Export Timeline > Frame.  

2. Click Settings.  

3. Choose a File Type. Click Advanced Settings for the file type you chose (if available), specify options, 

and click OK. For the Advanced Settings available for GIF.  

4. Click Next. In the Video Settings panel, specify the Frame Size and color Depth . 

5. Click Next. In the Keyframe and Rendering Options panel, specify options as needed.  

6. Click Next. In the Special Processing panel, click Modify, and specify options as needed.  

7. Click OK to close the Export Still Frame Settings dialog box.  

8. Specify a location and filename, and then click OK. 

Specifying the general export setting 
When you export from Premiere, the way you adjust settings for export depends on the kind of output you 

want: 

 When recording directly from the Timeline (File > Export Timeline > Print to Video or Export to 

Tape), Premiere uses settings from the Project Settings dialog box.  

 When exporting to a movie (File > Export Timeline > Movie), Premiere uses settings in the 

Export Settings dialog boxes.  

About compression 
Compressing the video program makes it play smoothly on a computer. When exporting a video program, 

you choose a compressor/decompressor, or codec, to compress the information for storage and transfer 

(such as on a CD) and to decompress the information so it can be viewed again. A wide range of codecs is 

available; no single codec is the best for all situations. For example, the best codec for compressing cartoon 

animation is generally not efficient for compressing live-action video. 

 Choosing export settings 
As part of the process of exporting, check the options in the Export Settings dialog box. The initial export 

settings are the same as the settings you specified in the Project Settings dialog box when you first started 

the project. Export settings don't update as you work on your project, however, so it's a good idea to make 

sure that all export settings are still the ones you want. Although the Export Settings dialog box is similar to 

the Project Settings dialog box, important differences exist.  

General export settings 
The following options are available in the General panel of the Export Settings dialog box: 

File Type 
Select the kind of file you want to export.  

www.a2zpapers.com
We provide GNDU question papers, PTU question papers, PU question papers, LPU question papers, GNA university question papers, PSEB question papers, HPSEB question papers, ICSE question papers and CBSE question papers.

a2zpapers.com

a2zpapers.com

a
2
z
p
a
p
e
r
s
.
c
o
m

a
2
z
p
a
p
e
r
s
.
c
o
m

a2zpapers.com

www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
a2zpapers.com
a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com


Page 30 of 44 
 

Advanced Settings 
Click if available. These options vary depending on the file type you choose. The following advanced 

settings options are available for Animated GIF or GIF Sequences: 

 Dithering: Select to simulate colors that are not available in the Web-safe color palette used by 

Web browsers. Dithering simulates unavailable colors using patterns that intersperse pixels from 

available colors. Dithered colors may look coarse and grainy, but dithering generally improves 

the apparent color range and the appearance of gradations. Deselect this option to move 

unavailable colors to the next closest color in the palette; this may cause abrupt color transitions.  

 Transparency: Select None from the menu to create the movie in an opaque rectangle. Select 

Hard to convert one color into a transparent area; click Color to specify the color. Select Soft to 

convert one color into a transparent area and soften the edges; click Color to specify the color.  

 Looping: Select if you want the animated GIF to play continuously without stopping. Deselect 

this option if you want the animated GIF to play only once and then stop. This option is not 

available for a GIF sequence. 

Range 
Select the range of time to export. If the Timeline or the Program view is active, you can select Work 

Area to export the frame range marked by the work area markers. If you are exporting from the Source 

view or a Clip window, and In and Out points are marked, you can select In to Out to export the marked 

range only. 

Export Video 
Select to export the video tracks, or deselect to prevent exporting video tracks. 

Export Audio 
Select to export the audio tracks, or deselect to prevent exporting audio tracks. 

Open When Finished 
Select if you want the exported file to be opened in Premiere after exporting is complete. 

Beep When Finished 
Select if you want Premiere to sound an alert when exporting is complete. 

Embedding Options 
Select Project Link from this menu if you want the exported file to include information necessary to use 

the Edit Original command. When a file contains this information, you can open and edit the original 

project from within another Premiere project or from another application that supports the command. 

Select None from this menu if you do not want to include the information. 

Video export settings 
The following options are available in the Video Settings panel of the Export Settings dialog box: 

Compressor 
Choose the codec (compressor/decompressor) for Premiere to apply when exporting a file, and click 

Configure (if available) to set options specific to the selected codec. The codecs available depend on the File 

Type you chose in the Export Settings panel.  
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Depth 
Choose the color depth, or the number of colors to include in video that you export. This menu may not be 

available if the selected Compressor supports only one color depth. You can also specify an 8-bit (256-

color) palette when preparing a video program for 8-bit color playback--for example, to match the colors on 

a Web page or in a presentation. When available, click Palette and then either select Make Palette from 

Movie to derive a color palette from the frames used in the video program, or select Load Palette Now to 

import a color palette that you prepared and saved previously. You can load color palettes in the .ACO 

(Photoshop color swatch), .ACT (Photoshop color palette), or .PAL (Windows palette--Windows only) 

format. 

Note: With the QuickTime file type, you can attach a 256-color palette to a movie of any bit depth. You can 

specify a palette for 24-bit movies to use when displaying on 8-bit monitors, and you can prevent palette 

"flashing" by attaching the same palette to many movies. Video for Windows supports attaching a palette 

only to an 8-bit movie. 

Frame Size 
Specify the dimensions, in pixels, for video frames you export. Select 4:3 Aspect to constrain the frame size 

to the 4:3 aspect ratio used by conventional television. Some codecs support specific frame sizes. Increasing 

the frame size displays more detail but uses more disk space and requires more processing during playback. 

Frame Rate 
Choose the number of frames per second for video you export. Some codecs support a specific set of frame 

rates. Increasing the frame rate may produce smoother motion (depending on the original frame rates of the 

source clips) but uses more disk space. 

Quality 
Drag the slider or type a value to affect the picture quality of and disk space used by exported video. If you 

are using same codec to capture and export, and you've rendered previews of the Timeline, you can save 

rendering time by matching the export quality setting with your original capture quality setting. For 

example, if you captured clips at 50% quality, set the export quality to 50% also. Premiere then performs a 

straight file copy of the data whenever possible, instead of recompressing the data frame by frame. 

Increasing quality above the original capture quality does not increase quality, but may result in longer 

rendering times.  

Recompress 
Select to ensure that Premiere exports a video file that is under the data rate you specified. Choose Always 

from the Recompress menu to compress every frame even if it is already within the data rate, or choose 

Maintain Data Rate to preserve quality by compressing only the frames that are above the specified data 

rate. Recompressing previously compressed frames may lower picture quality. Deselect Recompress to 

prevent current compression settings from being applied to clips that were not altered when you edited them 

into the program. 
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Audio export settings 

When you choose Audio Settings from the menu at the top of the Export Movie Settings dialog box, you can 

specify the following options: 

Rate  
Choose a higher rate for better audio quality in an exported file, or choose a lower rate to reduce processing 

time and disk-space requirements. CD quality is 44.1 kHz. Resampling, or setting a different rate than the 

original audio, also requires additional processing time; avoid resampling by capturing audio at the final 

rate. 

Format 
Choose a higher bit depth and stereo for better quality, or choose a lower bit depth and mono to reduce 

processing time and disk-space requirements. CD quality is 16-bit stereo. Stereo provides two channels of 

audio; Mono provides one channel. 

Compressor 
Specify the codec for Premiere to apply when compressing audio. The codecs available depend on the File 

Type you specified in the General panel in the Export Settings dialog box. Some file types and capture cards 

support only uncompressed audio, which has the highest quality, but uses more disk space. Check with your 

capture card's documentation before choosing an audio codec. 

Interleave 
Specify how often audio information is inserted among the video frames in the exported file. See your 

capture-card documentation for the recommended setting. A value of 1 frame means that when a frame is 

played back, the audio for the duration of that frame is loaded into RAM so that it can play until the next 

frame appears. If the audio breaks up when playing, the interleave value may be causing the computer to 

process audio more frequently than it can handle. Increasing the value lets Premiere store longer audio 

segments that need to be processed less often, but higher interleave values require more RAM. Most current 

hard disks operate best with 1/2- to 1-second interleaves. 

Enhanced Rate Conversion 
Specify a level of quality for converting the sample rates of clips in the Timeline to the sample rate you 

specified in the Rate option. Enhanced Rate Conversion controls both rate upsampling and downsampling. 

The Off option resamples audio the fastest, but produces moderate quality. The Good option balances 

quality and processing time. The Best option resamples audio for the highest possible quality but requires 

the most processing time. 

Logarithmic Audio Fades 
Select to process audio gain levels using the logarithmic scale used by the human ear and by conventional 

volume controls. Deselect this option to process gain changes using a linear curve. Selecting this option 

creates more natural-sounding changes as sounds become louder or softer, but may increase audio 

processing time. This option does not directly affect the audio faders in the Timeline--only the overall gain 

level. 
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Create audio preview files if there are: 

Type a new number in one or both of these boxes if you are experiencing poor playback performance due to 

more audio tracks or audio effects than your CPU can handle in real time. When you type a number below 

the actual number of audio tracks or effects used, Premiere renders audio preview files before playing back 

the video program. Rendering preview files requires extra rendering time, but improves playback 

performance. 

     Create audio preview files if there are: Type a new number in one or both of these boxes if you are 

experiencing poor playback performance due to more audio tracks or audio effects than your CPU can 

handle in real time. When you type a number below the actual number of audio tracks or effects used, 

Premiere renders audio preview files before playing back the video program. Rendering preview files 

requires extra rendering time, but improves playback performance. 

Key frame and Rendering export settings 

When you choose Key frame and Rendering options from the menu at the top of the Export Movie Settings 

dialog box, you can specify the following settings as needed: 

Ignore Audio Effects 

Select to export audio without processing applied effects. This option can be useful for exporting a rough 

cut, but remember to deselect it for the final cut. 

Ignore Video Effects 

Select to export video without processing applied effects. This option can be useful for exporting a rough 

cut, but remember to deselect it for the final cut. 

Ignore Audio Rubber Bands 

Select to process a video program excluding changes made using the Volume or Pan rubber band controls in 

the Timeline. This option can be useful for exporting a rough cut, but remember to deselect it for the final 

cut. 

Optimize Stills 

Select to use still images efficiently in exported video files. For example, if a still image has a duration of 2 

seconds in a project set to 30 frames per second, Premiere will create one 2-second frame instead of 60 

frames at 1/30 of a second each. Selecting this option can save disk space if you used still images. Deselect 

this option only if the exported video file exhibits playback problems when displaying the still images. 

Frames Only at Markers 
Select when you want to render only the frames at which you have added a Timeline marker. This option 

does not affect compression key frames. 

Fields 
Choose an option if required for your final medium. No Fields is the default and is the equivalent of 

progressive scan, the correct setting for computer display and motion picture film. Choose Upper Field First 
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or Lower Field First when exporting video for an interlaced medium such as NTSC, PAL, or SECAM. The 

option you choose depends on the specific video hardware you use. 

Key frame Every _ Frames 
Select and type the number of frames after which the codec will create a keyframe when exporting video.  

Add Keyframes at Markers 
Select to create keyframes only where markers exist on the Timeline. For this to work, markers must exist in 

the time ruler in the Timeline  

Add Keyframes at Edits 
Select to create a keyframe at the beginning of each clip in the Timeline. 

Note: Some codecs do not provide control over keyframes. In such codecs, the above options will not be 

available. 

Creating a text list of project files 
To document the contents of a project, you can export a text file that lists all the clips used in a project. The 

list displays the original filenames of clips, bins, and bin contents in the order in which they appear in a 

Project window. If a Bin window is active when you export, Premiere exports a file list for the project that 

includes the bin and its contents. In Windows, the file list contains the pathname to the file. In Mac OS, you 

can choose whether you want to include the full pathname. 

To export a file list: 

1. Activate a Project window.  

2. Choose File > Export Timeline > File List.  

3. Specify a location and type a name for the file list.  

4. (Mac OS only) Select Include Full Path Names if you want to include a complete folder path for each 

file in the list.  

5. Click Save. 
 

Using the Project window's bin view 
A Project window includes a bin view, which shows the bins that have been added to the project. The bin 

view appears on the left side of the Project window, and can be resized or hidden. When the bins in the bin 

view contain other bins, the hierarchical structure appears, much like the graphical view of folders and 

subfolders in your operating system.  

To hide or display the bin view:  

Choose Hide Bin Area or Show Bin Area from the Project window menu.  

To resize the bin view:  
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Drag the Resize Bin Area button located at the bottom of the Project window until you have the size you 

want. You cannot make the bin view smaller than the four buttons below it. To make it bigger, you may 

need to first make the Project window bigger.  

To add or delete a container in the bin view:  

 To delete one or more bins, select the bin and click the Delete Selected Items button () at the 

bottom of the Project window.  

 To add a bin, click the New Bin button () at the bottom of the Project window.  

To display the contents of a bin in the bin view:  

Select the bin. If the bin contains other bins, click the triangle beside the bin icon to display them, and then select the 

bin you want to view. 

Tools 

Selecting clips 
When you want to perform an action that affects a clip as a whole, such as applying an effect, deleting a 

clip, or moving a clip in time, first select the clip in the Timeline. The toolbox contains selection tools that 

can handle various selection tasks. 

To select one or more clips: 

Do any of the following: 

 To select a single clip, select the selection tool  

 ) and click a clip in the Timeline.  

 To select multiple clips by dragging, select the range select tool () and drag a rectangle that 

includes any part of the unlocked clips you want to select.  

 

 To select multiple clips by clicking, select the range select tool ()or the selection tool and hold 

down Shift as you click each clip you want to select. The range select tool selects clips in groups 

and the selection tool selects each adjacent clip or all clips between a previous selection and the 

current one. To use the selection tool to select or deselect individual clips in varying places in the 

timeline, hold down Command (Mac OS) or Ctrl (Windows) as you click the  

 To select all whole or partial clips that exist on and after a certain time on one track, select the track 

select tool () and click the clip at the beginning of the time span you want to select. Press Shift as you 

click to select clips on additional tracks. 

 

 To select all whole or partial clips that exist on and after a certain time on all tracks, select the multitrack 

select tool () and click the clip at the beginning of the time span you want to select. 

 

 To select a linked video clip or audio clip to edit independently of its partner, click the Toggle Sync 

Mode button () at the bottom of the Timeline window to turn off Sync mode (Sync mode is off when 
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there is no link icon visible in the Toggle Sync Mode button), and then edit the clip. When you are 

finished editing, click the Toggle Sync Mode button again to restore Sync mode. 

 

 Using Real-Time Preview 
 

Adobe Premiere 6.5 includes software-based Real-Time Preview among its Timeline preview options. 

You can preview the Timeline without any additional hardware. Premiere's Real-Time Preview supports 

all Premiere effects, transitions, transparencies, motion settings, and titles. You set all the preview 

options in the Project Settings dialog box. 

Premiere dynamically adjusts video quality and frame rate as it previews in real-time. When Premiere 

performs a real-time preview on a system with inadequate resources, or on a particularly complex 

section of the Timeline, the preview quality degrades gracefully. In this instance, fewer frames are 

played and the video drops to draft quality. 

Using the Adobe MPEG Encoder (Windows only) 
 

The Adobe MPEG Encoder is a Windows-only plug-in for Premiere 6.5 that creates high-quality 

MPEG-1 and MPEG-2 output for DVD, Super Video CD, and Video CD. The plug-in includes a variety 

of presets, making it easy to set the right parameters for generating MPEG files right from the Timeline. 

You can import and create additional presets. 

The Adobe MPEG Encoder is integrated with Sonic's DVDit!® LE, which is included with Premiere 

6.5. You can automatically export files from Premiere to the appropriate directory so that the files 

appear in DVDit!. You can also launch DVDit! automatically after exporting MPEG files from 

Premiere. The Adobe MPEG Encoder works equally well with the SE and PE versions of DVDit! For 

information on DVDit!, see the Sonic DVDit! LE documentation on the Premiere CD. 

The Adobe MPEG Encoder contains presets for DVD, VCD, and SVCD. These presets are designed to 

achieve an optimal blend of encoding quality and speed. The Advanced section of the Adobe MPEG 

Encoder dialog box includes more presets and provides additional settings for fine-tuning MPEG export. 

Understanding Advanced MPEG Settings 
 

The choices in the main Adobe MPEG Encoder dialog box cover most MPEG export and playback 

situations. However, if you want to fine tune these settings, use the Advanced MPEG Settings dialog 

box, which contains several options for creating MPEG files tailored for specific playback 

environments. The most powerful feature in the Advanced MPEG Settings dialog box is the Presets 

section. Presets are settings files that contain all of the necessary parameters for exporting. Presets make 

it easy to apply advanced settings to exported MPEG files without manually adjusting the settings. The 

Adobe MPEG Encoder includes a variety of popular presets. You can also load and save custom presets. 

Because MPEG preset files are small, you can easily transport them through e-mail or the Internet. 

For information on specific presets, as well as other advanced parameters, see the Adobe MPEG 

Encoder Help PDF included on the CD or check out the user forum on the Adobe Web site. You can 

also search the World Wide Web for user groups dedicated to the Adobe MPEG Encoder for more 

information. 
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Edit tools on time line 
1. Selection tool: - This tool is used for selection and moving clips, transition as well as markers 

and all these one at a time. This symbol changes to a stretch pointes when it is positioned at the 

edge of the clip so that the duration of the clip can be shortened or enlarged while dragging it 

when you are using some other tool you can hold down the command key so that the selection 

tool is accessed. 

 

2. Range selection tool:– You can select multiple items in the timeline window by dragging this 

tool over them. 

 

3. Edit tool: - The duration of a clip and its adjacent can be adjusted with        this tool so that the 

original combined duration of the two clips and the subsequent one can be maintained. 

 

4. Soft link tool: – With this tool, the duration of the duration of the clip can be adjusted without 

disturbing the duration of the other clips of the tract. 

 

5. Fade scissors tool: – With this tool two handles are created just next to each other in the fade 

control selection of an audio or superimposed clip you may make adjustments with these two 

handles  which will sharply increase or decrease the fading at a point . 

 

6. Link override tool:– You can move the video or audio part independently of a link clip. 

 

7. Fade adjustment tool: - With this tool a segment in the fade control section of an audio or 

superimposed clip can be uniformly adjusted. 

 

8. Zoom tool: - The function of this tool is same as the time unit slider which is present at the 

bottom of the timeline window. The zoom in tool decreases the time unit while the zoom out tool 

increases the time unit.   

 

9. Hand tool: - The content of the construct so as to display various portion of the movie. The 

scrolling takes place while dragging. 

 

10.  Block Select tool: - With this tool you can select segment of the same length from all the tracks 

in the construction window. 

 

11. Track tool: - This tool selects all the clips of the tracks i.e. first clip clicked to the end of the 

track. Hold down the shift key and click so as to add to a selection. 

 

12.  Multitrack tool: - All the clip in the construction window that are placed to the right of the point 

you click the selected with this tool. This includes the clips that start at a point earlier on the time 

line and those clips beyond the clicked point. Hold down the option click and click so as to select 

all clips and linked clips associated with a particular task. Hold down the shift key and click to 

add tracks to a linked clip selection. 

 

13.  Razor tool: - This tool is used to cut a clip into two or more dissiniliar clips. 

 

14.  In point and out point tools: - With these tools you can set the in point and out point for movie 

clips audio, transition and work area bar.Hold down the contro9l and shift key to select the in 

and out point when the selection tool is active. 
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ROTOSCOPING 
 

For either broadcast video or Internet streaming video, rotoscoping is the rotated projection of a sequence of 

usually photographed action image frames so that the artist can trace from the frame or create an image to 

superimpose on it. It can be thought of as "painting on movies" efficiently. Prior to computers, an animation 

stand called a Rotoscope was used to project a sequence of action frames against a surface so that a set of 

animation frames could be traced or created. The same work can now be done with digital images and special 

computer software. Tools that provide efficient ways to rotoscope include Digital Magic and Elastic Reality. 

Rotoscoping is frequently used as a technique for combining (compositing) cartoon figures with realistic 

settings in television commercials and is also used for special effects in feature-length films.  

A rotoscoping texture (sometimes called a sequence map) is the use of video within an animation, something 

like an animation within an animation. For example, in a cartoon animation, the television set could show a 

program containing another animation. Or in a background to an animation in the foreground, you could include 

some clouds that slowly changed during the foreground animation. The frame rate for both the main animation 

and the "animation within the animation" must be the same.  

S-Video 

S-Video (separated video), also known as Y/C and (incorrectly) S-VHS, is an analog video signal. S-Video will 

appear better than composite video since the television does not have to split the brightness and color 

information that are found together on composite video. The main advantages of separating these two signals 

are for better bandwidth of luminance and more effective work of chroma decoder. 

Short for Super-Video, a technology for transmitting video signals over a cable by dividing the video 

information into two separate signals: one for color (chrominance), and the other for brightness (luminance). 

When sent to a television, this produces sharper images than composite video , where the video information is 

transmitted as a single signal over one wire. This is because televisions are designed to display separate 

Luminance (Y) and Chrominance (C) signals. (The terms Y/C video and S-Video are the same.)  

Computer monitors, on the other hand, are designed for RGB signals. Most digital video devices, such as digital 

cameras and game machines, produce video in RGB format. The images look best, therefore, when output on a 

computer monitor. When output on a television, however, they look better in S-Video format than in composite 

format.  

To use S-Video, the device sending the signals must support S-Video output and the device receiving the 

signals must have an S-Video input jack. Then you need a special S-Video cable to connect the two devices.  

Streaming video 
 

Streaming video resembles conventional television in that video is sent to you frame by frame, without 

downloading a large file to your hard drive. Streaming video on the Web is constrained by the limited 

bandwidth (56 Kbps or less) of most consumer modems. However, streaming video can be deployed effectively 

within intranets where high-speed bandwidth is more readily available.  

The following streaming video formats are available for export from Premiere: QuickTime Streaming, 

Windows Media, RealVideo, and RealG2Streaming. You can create streaming video using any of the built-in 
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Web export options: Save for Web, Advanced RealMedia Export, or Advanced Windows Media Export 

(Windows only). 

Progressive downloadable video 

 

A progressive download movie (also called a hinted movie) can begin playing before it is completely 

downloaded. The movie player (for example, QuickTime, MediaPlayer, or RealPlayer) begins playback when 

it calculates that the movie will be fully downloaded by the time playback reaches the end of the video.  

The following downloadable video formats are available for export from Premiere: QuickTime Progressive 

Download, Windows Media, RealVideo, and RealG2 Web Download. You can create progressive download 

video using any of the Web export plug-ins: Save for Web, Advanced RealMedia Export, or Advanced 

Windows Media Export (Windows only). 

MPEG video 

 

Motion Picture Experts Group (MPEG) is a file format that compresses video files effectively but is not 

as standardized as QuickTime or AVI. There are actually several variations of MPEG. The version generally 

used for Internet and CD-ROM is MPEG-1, which provides picture quality nearly comparable to VHS. 

MPEG-2 can provide SVHS picture quality. However, the keyframe-based compression and variable bit rate 

that make MPEG popular for delivery of final video require significant processing time.  

You can create MPEG video using the Save for Web export option. 

MP3 audio 

 

Motion Picture Experts Group (MPEG) 1 Layer 3 is a file format that compresses audio files at a 1:24 to 1:5 

ratio. The high compression rate makes MP3 files smaller and of higher quality than most other audio formats.  

You can create MP3 audio files using the Save for Web export option. 

Animated GIF 

 

Animated GIF is best suited for solid-color motion graphics at a small frame size, such as an animated 

company logo. It works better for synthetic graphics than for live-action video. It is convenient because it is 

viewable in most Web browsers without requiring a plug-in, but you cannot include audio in an animated GIF 

file. Export animated GIF the same way you do any other file, making sure that you choose Animated GIF as 

the File Type. For best results, test completed Animated GIF files in a Web browser before distributing. 

Digital Video  

 

Capturing DV video differs from capturing analog video in several ways. Because the DV image is 

converted directly to digital format in the camcorder, it is ready to be stored on a hard disk and doesn't need to 

be digitized in the computer. Therefore, DV input doesn't need to be captured in the sense that analog video 

does; it merely needs to be transferred to your computer. To transfer DV in Windows or Mac OS, you need a 

capture card or computer with an OHCI-compliant interface.  

Your computer also needs a DV codec, which is provided in software as part of the operating system, or 

as a hardware chip on some capture cards. Premiere includes support for DV codecs and can read digital source 

video without further conversion. You can help prevent dropped frames by using a hard disk capable of 

sustaining the 3.6-MB-per-second data rate of digital video.  

A critical difference between analog capture and digital capture is how you set up Premiere before you 

begin. Before capturing DV, create a new project, and in the Load Project Settings dialog box, be sure to 

choose the appropriate DV preset.  
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Analog Video versus Digital Video 

decade ago, it was very easy to recommend one video format over another. If someone was planning to make 

money with their video, making many copies or wanted to do some editing, you simply aimed them at s-video, 

either Hi8mm or S-Video. If they just wanted to have fun, record family events and activities, then we aimed 

them towards regular 8mm or VHS. It was cut and dry.   

About 10 years ago, Digital Video entered the scene and suddenly became the leader for quality and for 

dubbing. Instead of ½ inch wide VHS tape or 8mm wide tape, it introduced a new format, 6.5-mm Digital 

Videotape or miniDV cassettes.  Recognizing a new marketing and technology trend, every major video 

manufacturer quickly jumped on the DV bandwagon and brought out their own family of DV camcorders. 

Some had one CCD chip, some had three. Some had color foldout viewfinders and some offered incredible 

optical focusing ranges. 

  DV camcorders were now the solution. That was, if you could afford it. DV cams were starting around $2500 

but you could get a Hi8 or S-Video camcorder for under a grand. 

  However, about five years ago, the whole market changed again as Sony introduced their new Digital 8 

camcorders. Not only did it record a true DV signal on inexpensive 8mm and Hi8mm videotapes cassettes, but 

you could also play back your existing 8mm and Hi8 tapes. They could play back either as a regular analog 

signal directly into your TV set or another VCR, or you could play them back as DV over a firewire/1394 cable 

connected to your computer for video editing and web purposes.  

  And the neatest thing was that it worked! I tested and reviewed the first batch of Digital8 camcorders and was 

quite amazed by how good the process actually was. Since the introduction of 8-mm video in 1985, Sony has 

estimated that the industry has shipped roughly 50 million 8mm camcorders throughout the world. That is a lot 

of people who might want to use the new D8 camcorders to play back old 8mm and Hi8 tapes.   

Specifying and adding a default transition 

 

The default transition can be applied quickly, without stopping to open the Transitions palette and drag 

the transition to the Timeline. Premiere automatically uses Cross Dissolve as the default transition, as it 

is one of the most commonly used transitions. If you frequently use another transition, you can set it as 

the default.  

The technique you use to add a default transition depends on whether you are editing in Single-Track 

mode or A/B Editing mode.  

To specify a default transition, and set the default duration and alignment: 

1. If necessary, choose Window > Show Transitions.  

2. Select the transition that you want to make the default.  

3. From the Transitions palette menu, choose Set Selected as Default.  

4. Type the default duration for the transition. (You can later change the duration, once the 

transition is added to the Timeline.)  

5. Choose the default alignment for the transition. This setting applies to transitions added when 

using the Single-Track Editing mode; when you use A/B Editing mode, transitions always fill the 

overlapping space unless you physically resize them using the trim tool.  
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6. Click OK. These settings remain in effect for all projects until you change them. 

To add the default transition to the Timeline: 

1. Do one of the following: 

1.  

 When the Timeline is in A/B Editing mode, position one clip in the Video 1A track and another 

clip in the Video 1B track so that some (or all) of the two clips overlap.  

1.  

 When the Timeline is in Single-Track mode, make sure that the Video 1 track is collapsed, and 

then position two clips on the Video 1 track so that they meet. 

Position the edit line where the two clips meet or overlap. 

Do one of the following: 

3.  

 In Single-Track mode, click the Apply Default Transition ( ) button in the Monitor window, or 

press Ctrl+D (Windows) or Command+D (Mac OS). If extra frames are not available at the In and Out 

points of the adjacent clips, the Fix Transitions dialog box appears. If necessary, select options from this 

dialog box. 

3.  

 In A/B Editing mode, expand the Video track in the Timeline if necessary, and then press 

Ctrl+Alt+Shift (Windows) or Command+Option+Shift (Mac OS) and click in the Transition track 

between two overlapping clips. 

Fading 
 

In addition to making portions of a clip transparent with keys, you can also adjust the opacity of the 

entire clip to fade it in or out. You can use fading to create additional transitional effects or to create 

simple superimposing.  

Cross-fading clips linked to video 
 

When audio clips are linked to video clips that don't overlap, cross-fading the audio clips is more 

complex than an audio-only cross-fade. The audio clips linked to video clips cannot be dragged 

to overlap if the video clips are on the same track. You can solve this problem by moving the clips onto 

different tracks. First turn off Sync mode, so that you can move or trim a clip independently of its linked 

video or audio.  

Cross-fading audio linked to video is useful when performing a split edit, in which a clip's video and 

audio start or end at different times. In one version of a split edit, called an L-cut, the audio Out point is 

later than the video Out point so that you can continue playing a video clip's audio after the next video 

clip's In point. Another kind of split edit is an audio lead, called a J-cut, which you use when you want 

an audio/video clip's audio to start playing before the video In point.  

 

Note: Cross-fading existing clips in the Timeline usually requires extending the duration of one or more 

audio clips. Whenever you extend the duration of a clip, additional frames must be available in the clip's 

source (master) clip beyond the current In or Out point. For example, if you didn't trim the beginning or 

ending of a source clip before adding it to the Timeline, the clip is already using all frames available 

from its source, so its duration cannot be extended. 

To cross-fade audio clips linked to nonoverlapping video: 
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1. If necessary, click the triangle to the left of each track name to expand the audio tracks you want 

to adjust.  

2. Click the Toggle Sync Mode button ( ) to deselect Sync mode.  

3. Drag one audio clip to a track where the audio can overlap the other audio clip in time. The 

tracks do not have to be adjacent.  

4. Drag the In or Out point of one audio clip to extend it as far past the edge of the other audio clip 

as needed. Make sure that only the In or Out point is moving, not the entire audio clip.  

5. Select the cross-fade tool ( ).  

6. Click the clip you want to fade out, and then click the clip you want to fade in. Premiere 

automatically creates and adjusts fade handles on both clips.  

7. Click the Toggle Sync Mode button again to select Sync mode. 

Rotating, zooming, delaying, and distorting 
 

For each motion keyframe on the path, you can set values for rotation, zoom, and delay, and define a 

shape for distorting the clip. By specifying different values at different motion keyframes, you can 

rotate, zoom, delay, and distort the clip over time. 

To rotate, zoom, or delay the clip: 

1. On the motion path or the timeline in the Motion Settings dialog box, select the motion keyframe 

at which you want to add rotation, zooming, or distortion. 

Drag the slider or type a value for the following controls as needed: 

2.  

 For Rotation, set the angle of rotation for a clip at the specified keyframe. The angle can range 

from -1440 degrees to 1440 degrees, resulting in up to eight full rotations (clockwise or 

counterclockwise) of the clip between keyframes. (One full rotation is equal to 360 degrees.) 

2.  

 For Zoom, increase or decrease the size of a clip at a specific keyframe on the motion path. The 

zoom percentage can range from 0 to 500. At 0, the clip is not visible; at 100, the clip is at its original 

size. 

2.  

 For Delay, direct the motion of a clip to pause for the specified amount of time. The delay value 

is a percentage of the duration of the clip. A delay percentage cannot exceed the distance in time to the 

next motion keyframe. When a delay has been added, a blue bar appears on the timeline, displaying the 

length of the delay.  

 Choose an option from the Motion menu to define how the motion should occur between the 

selected keyframe and the next keyframe. You can achieve smooth motion when zooming by speeding 

up or slowing down movement where necessary. When zooming from small to large, select Accelerate. 

When zooming from large to small, select Decelerate. 

 Repeat steps 1 to 3 for each motion keyframe you want to change. 

To distort a clip: 

1. In the motion path or timeline in the Motion Settings dialog box, select the keyframe at which 

you want to add distortion.  

2. In the distortion area, do any of the following: 

2.  

 To create distortion, drag one or more of the four corner points to other positions. 

2.  
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 To spin a distorted image around a center point, hold down the Alt key (Windows) or the Option 

key (Mac OS) and position the pointer on a corner point; then drag to spin the image around a center 

point. 

2.  

 To move all four corner points at once, position the pointer in the center of the image and drag.  

3. Repeat steps 1 and 2 for each motion keyframe that you want to distort. 

Replacing program frames using a three- or four-

point edit 
 

In the Monitor window, you can replace a range of program frames with a range of source clip frames. 

Premiere provides three-point and four-point edits, standard techniques in traditional video editing. 

In a three-point edit, for the source and program together, you mark either two In points and one Out 

point, or two Out points and one In point. This type of edit is useful when one end point of source 

material or program material is critical but the other is not. When you add the source frames to the 

Timeline, Premiere determines the fourth point by applying the duration of the In and Out points you 

specified to the third point. For example, if you mark a source In point of 00:03:15, a source Out point 

of 00:04:15, and a program Out point of 13:22:05, Premiere applies the 1-second duration between the 

source In and Out points to the program Out point, and automatically sets the program In point to 

13:21:05. You can leave any single In or Out point unmarked, but you must specify a total of three In 

and Out points. 

In a four-point edit, you mark source In and Out points and program In and Out points. A four-point edit 

is useful when the starting and ending frame in both the source and program are critical. If the marked 

source and program durations are different, Premiere alerts you to the discrepancy and provides 

alternatives to resolve it. 

You can preview three- or four-point edits by synchronizing the source and program controllers 

To perform a three-point edit: 

1. Set up the Take Video and Take Audio icons and the target program tracks (see  

2. In the Source and Program views, mark any combination of three In and Out points  

3. Click the Insert button ( ) or the Overlay button ( ). 

To perform a four-point edit: 

1. Set up the Take Video and Take Audio icons and the target program tracks Using the Source 

controller, mark an In point and an Out point for the source clip. Then use the Program controller to 

mark an In point and Out point for the program.  

2. Click the Insert button ( ) or the Overlay button ( ). If the marked source and program 

durations are different, select one of these options when prompted: 

3.  

 Change Speed distributes the range of source frames within the program In and Out points you 

specified, even though their durations are different. This causes the clip to play faster or slower. 

3.  

 Trim Source moves the source Out point you specified until the source frames fit within the 

program In and Out points you specified. The speed of the clip will not change. 

3.  

 Cancel Edit applies no changes. 
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Nesting edits using virtual clips 
A virtual clip is like a second video program that you create in the Timeline, separate from the main 

video program. Like the main program, a virtual clip can contain multiple clips, transitions, and effects, 

and can span multiple tracks. Once a virtual clip is defined, you can use it in the main program any 

number of times. Premiere treats and represents a virtual clip as a single clip, and you can edit and apply 

settings to a virtual clip as you can with a source video clip. By using virtual clips to organize and group 

sequences, you can save time editing complex video programs. Using virtual clips, you can do the 

following: 
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